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Revision History

Revision | Date Description

B.0O 8 June 2022 Updated Genexus™ Software release notes for Genexus™ Assay Development

Software 6.6.2.1.

Languages supported in Genexus™ Assay Development Software 6.6 and antivirus

software.

The following issues are fixed in Genexus™ Assay Development Software 6.6.2.1.

e  28040. Security vulnerability.

24649. Unresponsive system after data backup.

26086. Raw data storage and deletion.

25465. Display of average base coverage depth results.

26088. Operator role permissions.

1399. Salt bridges.

1425. Alert shown when not necessary.

1435. Missing PCR lid failure alert.

1421. Motor configuration issue on the sequencer.

The following known issues were added.

o 30178. Plugins that are run after a run is complete cannot be run while backup

is in process.

28945. Import single runs from another Genexus™ Integrated Sequencer.

29228. Edit default report template.

29089. Manager role.

28490. Import custom baselines.

25307. Manual signature title.

20701. Downloads of sequencing results from the Oncomine™ TCR Beta-LR

Assay GX assay.

e 25474. Potential pool imbalance when selecting UDG option for AmpliSeq DNA
and AmpliSeq DNA&RNA Assays.

e  29239. Manual and automated backups.

e 29905, 30233, and 30234 Generate and download variant reports.

e 28908 JNPL file.

A.0 28 February 2022 New release notes for lon Torrent Genexus™ Assay Development Software 6.6.

Release Notes Overview

This document outlines major features in lon Torrent™ Genexus™ Assay Development Software 6.6, issues
fixed in Genexus™ Assay Development Software 6.6.2.1 and Genexus™ Assay Development Software
6.6.0.3, and known issues to be fixed in subsequent releases.
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Languages supported in Genexus™ Assay Development
Software 6.6

Genexus™ Assay Development Software 6.6 supports the following languages:

e English e ltalian

e Chinese e Japanese
e French e Spanish

e German

Languages supported by the help system and documentation

The Genexus™ Assay Development Software 6.6 help system and documentation supports the following
languages:

e English e Bulgarian
e Chinese e Croatian

e Czech e Danish

e Dutch e Estonian

e French e German

o Greek e Hungarian
e ltalian e Japanese
e Latvian e Lithuanian
e Norwegian e Portuguese
e Romanian e Russian

e Slovak e Slovene

e Spanish e Swedish

e Turkish

Future releases will support Polish, Vietnamese, Indonesian and Korean languages.

Antivirus software

We have tested Genexus™ Assay Development Software 6.6.2.1 with the following antivirus software
products and found them compatible as antivirus solutions:

¢ Bitdefender GravityZone™ Business Security with definition files updated on 6 May 2022
e Kaspersky™ Endpoint Security for Linux with definition files updated on 5 May 2022
e ESET NOD32 with definition files updated on 12 May 2022

Note: Antivirus Software definition files are updated frequently, sometimes daily. Definition file updates for
antivirus software can bring additional settings or updates to the system which may affect the function of

Genexus™ Assay Development Software.

Genexus™ Assay Development Software 6.6 Release Notes



Issues fixed in Genexus™ Assay Development Software 6.6.2.1

patch

Issue number

Issue Summary

Impact

28040

A critical security vulnerability was detected

in the following third party libraries.

e Spring framework versions 5.3.17 and
earlier

e Spring Boot versions 2.5.11 and earlier

e Apache HTTP server version 2.4.52 and
earlier

Genexus™ Assay Development system

software uses these third-party libraries and

used versions that were impacted with these

vulnerabilities.

The security vulnerability is fixed as part of the
6.6.2.1 patch release by upgrading Spring
Framework version to 5.3.18, Spring Boot
version to 2.5.12 and Apache HTTP server
version to 2.4.53 which are included in the
software. This issue is fixed in Genexus™
Assay Development Software 6.6.2.1.

24649 The Genexus™ Integrated Sequencer This issue is fixed in Genexus™ Assay
became unresponsive after backups. Based | Development Software 6.6.2.1.
on the backup settings, the sequencer backs
up runs and saves data from the runs in the
backup directory. The software query to fetch
run data was at times using excess memory
causing the sequencer to become
unresponsive.

24649 Based on the backup settings, the sequencer | This issue is fixed in Genexus™ Assay
backs up runs and saves data from the runs | Development Software 6.6.2.1.
in the backup directory which was at times
consuming excess memory and processing
causing the system to become unresponsive.

26086 Disk space was used to store raw data that This issue is fixed in Genexus™ Assay
should have been deleted in Genexus™ Development Software 6.6.2.1.

Assay Development Software for runs with a
status of Analysis Complete.

25465 QC values were shown incorrectly as N/Ain | This issue is fixed in Genexus™ Assay
the QC tab even though the analysis Development Software 6.6.2.1.
generated values for the QC.

26088 In Genexus™ Assay Development Software | This issue is fixed in Genexus™ Assay
6.6.0.3, users who were assigned the role of | Development Software 6.6.2.1.

Operator were not able to view plugin results
or the pileup view in Sample Results.

1399 On some instruments, after a run completes, | This issue is fixed in the Genexus™ Assay
leftover fluid may leak out from the chip Development Software 6.6.2.1. To prevent
clamp and dry, forming a “salt bridge” that potential leaks from occurring after the fourth
leads to electrical noise during signal lane of a chip is used in a run, the chip remains
detection for follow on runs. clamped in the sequencing position until all

lanes are used. You will be prompted to remove
the chip before you load the instrument deck for
a new run.

1425 The annual maintenance alert “The This issue is fixed in the Genexus™ Assay

instrument needs to be serviced” was shown
on the instrument every 4 weeks.

Development Software 6.6.2.1.
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Issue number

Issue Summary

Impact

1435

The instrument software did not show an
error when the PCR lid failed to close and
the instrument continued the run. This issue
occurred after the instrument was serviced
and a connection was loose. A loose
connection can cause poor thermal
uniformity during library amplification which
biases amplicon coverage of the sample.

This issue is fixed in Genexus™ Software
6.6.2.1. If the PCR lid fails to clamp an error
message is shown that the PCR lid is not
behaving as expected. If you see this error
message, please contact your Field Service
representative to schedule a repair.

1421

On rare occasions the coupler shuttle on the
instrument failed to clamp at the pipette
loading position. The error shown on the
instrument was “Coupler Shuttle failed to
Engage-hi”. This error occurred because
motor default configurations were being
overwritten when the coupler shuttle was
moved by the instrument.

This issue is fixed in Genexus™ Assay
Development Software 6.6.2.1.

GX 6.6 Key Features

Support integration of the lon Torrent™ Genexus™ Purification Instrument

The lon Torrent™ Genexus™ System is the first turnkey next-generation sequencing (NGS) solution that
automates the sample-to-report workflow and delivers results in a single day. Genexus™ Assay
Development Software 6.6 can be used to plan the Sample to Result run with the integrated Genexus™
Purification Instrument and Genexus™ Integrated Sequencer. The software tracks samples from purification
through sequencing to post-run sample reports.

Dashboard

The dashboard is the home screen for the software. In the software dashboard, you can view details, such
as the QC status, for the five most recent runs, the status of the instruments that are integrated with the
software, and instrument alarms, if any.

Custom variant reports

With custom variant reports, you can perform the following functions.

e Create custom report templates. In the template, you can customize sample details, variant sections,
custom text, images, electronic signatures, and manual signature sections.
Add descriptions, titles, and footnotes to each section of the template.
Add custom text and images to the template that you can edit when you generate the report.

e Associate up to 3 default templates for an application category. When default templates are
associated with an application category, a variant report is generated at the end of the run.

e Select the report language.

¢ Include images shown in the results screens in reports.

Positive control

You can include a positive control for Sample to Result runs.

Multiple electronic signatures for variant reports

Multiple users can electronically sign variant reports. The electronic signatures appear in the PDF report. In
addition, multiple signature levels can be enabled in the software. One signature level can be designated to

lock the report to prevent further changes. The first user who signs the report can modify the report template

selection and modify the report. Subsequent users can only sign the report and add comments. Reports can

be amended until 30 days after a run is complete.

You can also send notifications to other users in Genexus™ Assay Development Software. For example, you
can notify another user when you have signed a variant report.
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Results screens

e The Key Variants matrix provides a color-coded visual representation of the variant results. Each tile
in the Key Variants matrix represents one variant and indicates whether a variant is detected or not.

o Amplicon coverage graphs provide a high-level overview of coverage to help you determine
whether the sequencing reads across a gene are uniform and sufficient.

e Variant tracks are shown with the pileup view in Genexus™ Assay Development Software. The
pileup is a figure generated in the software that shows each BAM track represented by a single bar,
with the sequence variation or variations denoted in each track. The BAM tracks are aligned against
a reference track. The variant pileup can be used to identify potential variants.

e The variant results shown in the Key Findings are organized into the following categories: Key
Variants Detected, Other Variants Detected, None Detected, and Not Assayed.

Data backup

You can automatically back up older run data, results files, and signed reports to local or cloud storage and
set a schedule to automatically delete backed up runs after a specified amount of time.

Enable LIMS sample attribute and vocabulary mapping

You can map the names of sample attributes that are used by external LIMS software to the names of the
sample attributes recognized by Genexus™ Assay Development Software 6.6. The mapped sample
attributes are associated with one or more application categories. LIMS attribute mapping allows you to
seamlessly import a file, in XLS, CSV, or TSV format, that you have exported from external LIMS software to
add samples in the software.

You can also map alternate vocabulary values for sample attributes that are not recognized in the software.

Variant classifications are shown in VCF files

Custom classifications, such as benign or likely pathogenic, that you create and assign to variants, are
included in VCF files that you can download.

TNA custom assay creation

You can create custom assays for total nucleic acid (TNA) to detect and annotate DNA and fusion variants
from cell free nucleic acid.

Sample management

You can copy and edit multiple samples at once. You can also add sample tags to one or more samples or
sample results. Sample tags can be used to group and track samples in the software. The tags that you
create can be nested. You can easily find samples when you search or filter the samples or sample results
according to a sample tag. Sample tags are also supported in the LIMS API.

Encryption of sample information
Sample information is stored in an encrypted format in the software.

Edit a sample after a run is complete

In Genexus™ Assay Development Software 6.6, after a run is complete, a manager- or administrator-level
user can edit a sample for 30 days. You must reanalyze the sample to generate results and a new variant
report for the sample.

Sign in
You must select and answer security questions the first time you sign in. The security questions are used to
validate identity when the password is reset.

Enable custom RNA Exon Tile assay baselines and sequencing variants baselines

You can generate panel specific custom RNA Exon Tile assay baselines and sequencing variant baselines.
You can also export, import, and obsolete the custom baselines.
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Enable import from AmpliSeq.com

Manager- and administrator-level users can directly import custom or fixed panel files into Genexus™ Assay
Development Software from lon AmpliSeq™ Designer.

Enable reanalysis

If a sequencing run fails to meet one or more QC parameters defined by the assay, you can adjust the assay
parameters and reanalyze a sample or a run. Reanalysis of runs per assay can start from the alignment,
basecalling, or signal processing steps. A sample can be reanalyzed starting only from the alignment step.
For both runs and samples, the files needed for the stage of reanalysis that you select must be present in the
software.

GRCh38 Support

Genexus™ Assay Development Software 6.6 includes the GRCh38 reference genome file as a preset to use
in assays.

User experience

¢ You can search, filter, and sort the information that is shown in the software screens from each
column header in the tables. This allows you to search and filter the information with multiple filter
options enabled sequentially. This applies to the information shown in the samples, assays, run
plans, and results screens.

e Actions that are available for an item in a table, such as copy or edit a sample in the Manage
Samples screen, are shown when you place the pointer over a row.

e System notifications are shown with an alert and notifications button in the menu bar.

BAM to Result workflow
You can create samples from BAM files, then plan BAM to Result runs to analyze the BAM samples.

Extraction and control kit barcodes

You can track samples with the extraction kit barcode associated with the sample when you plan a Nucleic
Acid to Result run. In addition, you can track control kits with the control kit barcode when you plan a Nucleic
Acid to Result run. The barcodes are shown in the software screens and in the variant report PDF file.

Enable support of Genexus to Genexus sample and BAM file transfer

You can upload BAM files to another Genexus™ Assay Development Software server and enable analysis in
the target server to start immediately after the files are transferred. You can enable the file transfer when you
plan a run or you can upload result files after a run is complete.

Issues fixed in Genexus™ Assay Development Software 6.6.0.3
Security patch

Issue

number Issue Summary Impact and Mitigation
23661 A security vulnerability affects log4j The log4j and logback security vulnerability is fixed in
versions 2.0 through 2.15.0 and the 6.6.0.3 security patch release.

logback used by Genexus™ Assay

Mitigation: Ensure that Genexus™ Assay
Development Software 6.6.

Development Software is updated with the 6.6.0.3
security patch.

logdj and logback packages included in Genexus™ Assay Development Software 6.6.0.3

Your use and installation of Genexus™ Assay Development Software 6.6.0.3 will be deemed to constitute
your acceptance of the terms and conditions of all the third party licenses that are listed below. The log4j
versions used by Genexus™ Assay Development Software 6.6.0.3 are not listed in the EULA’s Appendix of
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third-party copyright notices and licenses. The log4j version information that is not listed in the EULA is a
known issue that will be fixed in an upcoming release of the software.

Package Version License

log4j 1.2.17 APACHE LICENSE, VERSION 2.0

log4j 1.2.15 APACHE LICENSE, VERSION 2.0

log4j 2.17.0 APACHE LICENSE, VERSION 2.0

Logback-core 1.2.9 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1
Logback-classic 1.2.9 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1

Known issues in Genexus™ As
and 6.6.2.1

say Development Software 6.6

Issue e 4
number Issue Summary Impact and Mitigation

30178 If you click Run Plugin for a sample | This issue occurs if you click Run Plugin to re-run any
result while data backup is in plugin while data backup is in progress. After this
progress, the 1.wells files, the issue occurs, all later runs are affected. Affected
basecaller output, and the . results include coverageAnalysis and
coverageAnalysis plugin source files | molecularCoverageAnalysis plugin results and QC
for the sample result are deleted. If metrics.
téns ISsue occurs, the_ Loading Mitigation: Do not run re-run any plugin after a run is

ensity image and histograms are complete while data backup is in progress or if there is
not shown in the Assay Metrics and h Vsis i Cont tg FBS or FSE if
Run Report screens and values are another analysis in process. Lontact an or !
absent for some QC metrics you observe that the Loadlng Density image and
Note: The affected run repoﬁ data histograms are not shown in the Run Report screen
are available in the Run Report PDF. or values are absent for some QC metrics.

28945 If sequencing run results are Only runs with signed reports that are imported from
imported to another Genexus ™ one system to another are affected.

Integrated Sequencer, a signed Mitigation: You can optionally sign off the report after
report that is locked for electronic the report is imported or view the existing report with
signatures is shown as a draft report | 4,0 sign off information

on the system with the imported '

results. The draft PDF report shows

the electronic signature details for

the sign-off.

29228 If there are three report templates This issue occurs only when there are three default
marked as Default for an assay or | report templates for the assay or application category.
application category, you cannot edit | mitigation: Remove the Default selection during
the report template. editing, then set the report template back to default.

Click Assays» Manage Presets» Report
Templates, then in the row of the report template,
click Undo Default or Set as Defaulit.

29089 Users assigned to accounts with the | This issue affects only users accounts that are
Manager Role are unable to access | assigned Manager Role permissions.

Audit records for the Services Mitigation: Sign in as an Administrator-user to view
screen and Sample Attribute all audit records.
mapping.
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:fjr‘:l?aer Issue Summary Impact and Mitigation'

28490 Custom baselines (CNV baselines, This issue affects the import of custom baselines from
sequence variant baselines, exon tile | one Genexus™ system to another Genexus™
assay baseline) created on one system.

Genexus™ system cannot be Mitigation:
|mporteq to another Genexus ™ e Create CNV and sequence variant baselines, then
system in ZIP format. import the baseline files in H5 (CNV) or BED
(SVB) format.
e Import exon tile assay baselines in TXT format.

25307 The manual signature title of a report | This issue affects only the manual signature titles
is not displayed correctly when the when a default report template is used.
default report template is used. Mitigation: For reports with a manual signature, use a

report template that is not set as default to view the
correct title for the manual signature in the report.

20701 Downloads of sequencing results This issue affects only files available to download for
from the Oncomine™ TCR Beta-LR | results from the Oncomine™ TCR Beta-LR Assay GX
Assay GX assay that include assay.
unmapped BAM and FASTQ files do | Mitigation: When you download the files, do not exit
not show a dialog box that shows the | from the software. Files are available after
download has started and is approximately five minutes.
successful.

25474 The Uracil DNA Glycosylase (UDG) | This issue affects assays for DNA or DNA and
Treat DNA setting is used to clean Fusions if you enable the UDG Treat DNA parameter
up deaminated Cytosine bases from | in the Library Prep & Templating section of the
degraded samples. If you enable the | Parameters step in assay creation or when you copy,
UDG Treat DNA parameter in an then edit an assay. The issue can result in over
assay, you may observe read dilution of nucleic acid prior to library prep for
imbalance in the Barcodes with AmpliSeq, and over dilution of the second pool in
Reads Reported table. Read AmpliSeq and AmpliSeq HD two pool assays, leading
imbalance can occur because the to pool imbalance in the final reads.
on-instrument dilution of input Mitigation:
sample nucleic acid is impacted by If possible, do not enable the UDG Treat DNA
this setting. parameter for AmpliSeq HD assays with two or more

pools and for AmpliSeq assays. Manually dilute the
DNA sample if UDG treatment is necessary. Contact
an FAS for help.

29239 If manual and automated backups When you use the Backup and Restore option, do not
occur at the same time, the use the Start Now backup option if you want to back
intermediate files may be deleted up intermediate files.
without a successful backup.

29905 If you enable Generate Report This issue affects only variant reports that are
when you plan a run, you cannot selected for download as part of the Reports list in the
download variant reports when you Download Files dialog box.
click ...(More Options) » Download | Mitigation: Click Lab Reports in the Download Files
Files and select the Reports dialog box to download variant reports.
checkbox in the Download Files
dialog box.

30233 If you enable Generate Report This issue affects report templates for non-English
when you plan a run, the report that | languages that are selected for generation when you
is generated is always in English plan a run.
regardless of the language that is Mitigation: To create reports in languages other than
associated with the report template. English, do not enable the Generate Report option

when you plan a run. Instead, use the Reports tab to
generate reports after the run is complete.
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Issue

Issue Summary

Impact and Mitigation'

number

30234 If you enable Generate Report This issue affects only the language information that is
when you plan a run, the language is | shown. The report is generated in English.
not shown in the pane for the report
in the Reports tab.

28908 For some results, the ClinVar track is | This is an intermittent issue that affects only some
not shown in the Integrative results with ClinVar annotations.

Genomics Viewer (IGV) view thatis | pitigation: Use the pileup view in Genexus ™
generated with the JNLP files that Software.

are downloaded from Genexus™

Software.

20875 For samples with a disease category | This issue affects samples created in Genexus™
of cancer that were created in Software 6.2. Disease category was a sample
Genexus™ Software 6.2, you cannot | attribute in version 6.2, but in version 6.6, the
plan a run or generate a report correlated attribute is application category. (Cancer is
unless you first edit the application not an available option in version 6.6.)
category of the samples. Mitigation: For samples with a disease category of

cancer created in Genexus™ Software 6.2, edit the

application category before you plan a run or generate

a report with the samples in Genexus™ Assay

Development Software 6.6. Alternatively, you can

copy samples that you created in version 6.2, edit the

application category for version 6.6, then plan a run
with the new samples.

20720 If you have added all available This rare issue occurs only when you select all
columns to the list of samples in the | available columns in the Columns dropdown list and
Samples / Manage Samples screen | do not save the column preferences, then use the filter
and then try to filter the list of tool in the Tags column.
samples with the Tags column, an Mitigation: Before you use the Tags column to filter
error message is shown. the list of samples, save any new column preferences

or ensure that at least one available column is

unselected.

21585 When you edit multiple samples at This issue occurs only when you change the cellularity
once and change the cellularity or or necrosis value of a sample when you have selected
necrosis value for one sample, the multiple samples to edit together.
new value is applied to all samples | gjtigation: Only change the cellularity or necrosis of
in the Edit Sample screen. a single sample at a time.

1. In the Manage Samples screen, place the pointer
over the row of a sample that you want to edit,
click Edit.

2. Change the cellularity or necrosis value of the
single sample.

21293 If you create a custom sample This issue affects only custom sample attributes with a
attribute with an attribute name that period in the name of the attribute.
contains a full stop or period (.), the Mitigation:
entries for t_hat sample attribute are e View the entry for a custom sample attribute for a
not shown in the Manage Samples single sample. (Click Samples» Manage
table. Samples, then click a sample name.)

e When you create a custom sample attribute, do
not include a period in the name of the attribute.

20696 In any column header, when you This issue applies to all searches in the filter dialog

click Filter, enter any information in
the search field, then click Enter, all
options that are listed in the filter
dialog box are selected.

boxes in all screens.
Mitigation: In the filter dialog boxes, do not click
Enter except to select all options.

Genexus™ Assay Development Software 6.6 Release Notes
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:fjr‘:l?aer Issue Summary Impact and Mitigation'

16405 If you have completed a run with This issue affects results generated in version 6.2,
Genexus™ Software 6.2, then then viewed in the version 6.6 software.
upgrade to Genexus™ Assay Mitigation: Although you cannot download a PDF file
Development Software 6.6, the run | ¢ the run report, you can view the information that is
report is not available to download. | ghown in the run report when you view the Assay

Metrics for each assay in the run.

21487 BAM to Result runs are not This issue affects all system-installed or custom
compatible with assays that are assays from Genexus™ Software 6.2.1 or earlier.
created or installed in previous
versions of the software.

21985 If you perform a run with a sample, This issue affects all samples that are included in at
then perform a second run with the least two completed run plans.
same sample, you cannot edit the Mitigation: Ensure that all sample information is
sample information if needed after correct before you assign a sample to a second run
the second run. plan. To preserve the option to edit a sample for 30

days after a run is complete, copy a sample that has
been included in a completed run, then assign the
new, copied sample to a run plan.

20742 If you enable the option to upload This issue affects only immune repertoire assays
immune repertoire BAM files to when you plan a run.
another Genexus™ Software server | mitigation: After the sample data is transferred to the
when you plan a run, the option to target server, plan a BAM to Result run with the
perform an analysis in the target transferred samples.
software automatically after run
completion is not available.

21916 If the connection between the This rare issue occurs only if you try to switch the
sequencer and the software is mode while a run is in progress and the connection
interrupted while a run is in progress, | between the instrument and the software is lost.
an then you try to switch from the Mitigation: Do not switch the software mode while a

ssay Development mode to the Dx ) .
mode, you are not notified that a run run is in progress. E_»efore you switch software modes,
is in progress. Instead, a message complete the following.
appears that indicates that the e In Genexus™ Assay Development Software,
connection to the instrument has check the Dashboard screen to confirm that there
been longer than 32 hours. are not any runs in progress.
However, you are allowed to switch | ¢  On the Genexus™ Integrated Sequencer, ensure
the mode. that all runs are completed and that the instrument

does not have a connection failure alarm.

23545 NTC QC results for Sample to Result | This issue affects Sample to Result runs for some
runs are only visible for samples that | system-installed or custom assays that include more
are included in the purification batch | than one purification batch.
with the NTC. Mitigation: In the Run Summary, in the Batch ID

column, view the purification batch of samples and the
NTC. To view NTC QC results, view the QC tab for a
sample that was included in the purification batch with
the NTC.

21485 If you try to compare immune This issue affects only the comparison of immune
repertoire results from BAM samples | repertoire results from BAM samples that have been
that have been uploaded from uploaded from another Genexus™ Software server.
another Genexus™ Software server,
no comparison results are shown.

Genexus™ Assay Development Software 6.6 Release Notes
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Issue

Issue Summary

Impact and Mitigation'

number

12692 Missing variant label and legend This is a chart customization issue that does not affect
chart customization options for sequencing results.
charts generated when you compare
samples.

22549 In the Key Findings tab, in the This issue affects all genes transcribed from the
Coverage Graph for genes that are | reverse strand.
transcribed from the reverse strand, | mitigation: Ignore the exon numbers that are shown
Fhe order of the exons is shown in the transcript track.
incorrectly when you place the , , , ,
pointer over the transcript track. For instructions to view the transcript and get the
Exons are always numbered left to correct exon numbers for coverage metrics, see View
right, ignoring directionality of the the correct orientation of transcripts that are
gene. transcribed from the reverse strand.

22895 In the Key Findings tab, in the Key | This issue can affect variants with more than one
Variants matrix, variants with more gene annotation; for example, U2AF1L5/U2AF 1.
than one gene annotation can be Identify if a variant is affected by this issue.
listed as Not Assayed evenifone of | 4 £qr any gene tile that is shown only when the Not
the annotated genes is present in Assayed checkbox is selected, click the Variant
the pan_el. Affected va_rlants are ID to open the Variants tab.
shown in the Key Variants matrix 2. Scroll up to view the variant in the Variants table.
only when the Not Assayed 3. In the Variants table, in the Gene column, if the
checkbox is selected and appear at variant is listed with ** to indicate that more than
the end of the matrix in a white tile one gene is detected, click the Annotations tab.
instead of a blue tile. 4. Scroll to the Gene row to view the multiple

annotations for the gene.
Example: e : . .
Mitigation: When you view the Key Variants matrix,
U2AF1L5 SNV/Indel ensure that you select the Not Assayed checkbox, if
COSM166866 available, to review variants that are not assayed.
AA Change: p.?
Allele Frequency: 0.066
22883 If you select a gene that is not This issue affects some genes that are not shown by

shown by default in the Coverage
Graphs, in some cases, the
coverage graph is not shown for the
gene that you select.

default in the Coverage Graph. Even if the graph is
labeled correctly with the selected gene, the coverage
information is not updated correctly.

Mitigation: Ignore the Coverage Graph that appears
when you first select a gene from the Show Coverage
for Gene dropdown list. Refresh the browser window
to view the correct Coverage Graph for the gene.
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Issue

Issue Summary

Impact and Mitigation'

reads shown in the BAM track is not
consistent each time you view the
BAM track in the Gene Browser.

number
23074 The Oncomine Extended (5.14) This rare issue affects results that are viewed when
filter chain launched in Genexus™ the Oncomine Extended (5.14) filter chain is applied
Software 6.2.1 was updated in and compared to results in Genexus™ Software 6.2.1.
Genexus™ Assay Development This rare issue could affect the following Filtered
Software 6.6. The improvements, Variants.
which are part of Oncomine o Likely somatic de novo splice variants that are not
Extended (5.16) filter chain, are also hotspot splice variants or ClinVar pathogenic
included in the Oncomine Extended variants are filtered in. (Hotspot splice site variants
(5.14) filter chain in Genexus™ and ClinVar pathogenic variants are not affected
Assay Development Software 6.6. by this issue.)
This update can result in rare
differences to Filtered Variants in
Genexus™ Assay Development
Software 6.6 when compared to
results viewed with the Oncomine
Extended (5.14) filter chain in
Genexus™ Software 6.2.1.
21778 For some assays, when you view all | This issue occurs only for some assays when you
of the variants in the Variants table, | view all variants in the Variants table. The data in the
you can add the P-Value column to duplicated columns are the same.
the table twice. Mitigation: You can ignore or remove the duplicated
P-Value column in the Variants table with the
Columns dropdown list. Alternatively, you can view
the SNVs/Indels or CNVs tables. A single P-Value
column is available in the SNVs/Indels and CNVs
tables.
23399 The option to create a custom filter This issue affects custom filter chains created to filter
chain to filter variant results by allele | variant results by allele frequency.
frequency does not appear to be Mitigation: Select the Allele Fraction filter to create a
available (Assays»Manage custom filter chain to filter variant results by Allele
Presets» Filter Chains» Add Frequency.
New» Choose Filter).
21930 If you create a custom filter chain for | This issue affects all custom filter chains that include a
a variant classification, then try to Variant Classification filter.
apply the custom filter chain to a Mitigation: Find and filter user classifications in the
result, a “Data not available” following ways.
message appears. e In the Variants tables, in the User Classification
column header, use the filter and search tool to
limit the variant classifications that are shown.
¢ Download the Filtered Variants VCF file to view
and search for variant classifications.
17425 In rare instances, the order of the This issue occurs only when the total read count

exceeds the maximum read count threshold that is set
for optimal browser performance. When the threshold
is exceeded, the Gene Browser shows a specified
number of randomly sampled alignments configured
by downsampling parameters. The coverage track is
not affected by this issue.

Mitigation: You can adjust the downsample reads
parameter and view the full BAM track with the Broad
Institute Integrative Genomics Viewer (IGV). For more
information, see “View variants with IGV” in the
software help system.
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Issue

Issue Summary

Impact and Mitigation'

number

21794 In the Gene Browser, in some This issue occurs only for some variants. There is no
instances, the target region is impact to the data, except for the color change in the
represented with a black color image.
instead of green.

13478 When you click any of the links for This issue occurs when you click any of the links for
the Exome Aggregation Consortium | the EXAC browser.

(ExAC) browser in the Annotations | pitigation: Click the updated gnomAD browser link or
tab shown below the Variants table, |\ 4it'to be redirected.
the following message is shown:

“The ExXAC browser is no longer

available. EXAC data is available in

the gnomAD browser or can be

downloaded from gs://gnomad-

public/legacy.

View this page in the gnomAD

browser. You will be automatically

redirected in 24 seconds. *

23068 If you create a custom panel for the | This rare issue affects the visualization of BRCA1 for
Oncomine™ BRCA Assay GX, exon | the Oncomine™ BRCA Assay GX if you use a custom
numbering remains set by the panel with a version of the reference sequence that is
system-installed panel for the assay. | different from the system-installed panel for the assay.
As a result, when you use a custom | The system-installed version of the reference
panel that is based on a reference sequence is NM_007294 .4.
sequence version that is different
from the system-installed panel,
exon numbering for BRCA1 is not
correct when you visualize exon and
whole gene CNVs.

23057 When you view the exon tile fusion This issue affects the charts that are shown for the
imbalance charts for a sample, then | RNA exon tile fusion imbalance results for the
select a different sample, the charts | Oncomine™ Precision Assay GX.
are not updated for the new sample T
that is selected Mitigation:

) 1. Leave the Results section. For example, click
Dashboard.

2. Click Results» Sample Results, then click the
sample name for the RNA exon tile fusion
imbalance charts that you want to view.

3. Click the Variants tab, then click Fusions.

4. Click Visualization» RNA Exon Tile Fusion
Imbalance.

21541 If you import a custom exon tile This issue occurs only if you attempt to import a
assay baseline file in an custom exon tile assay baseline file in an unsupported
unsupported file format, you are not | file format.
notified that the import failed. The Mitigation: Ensure that custom exon tile assay
unsupported file appears in the Exon | ,aqelines that you import are in a supported file
Tile Assay baselines list after import. | (.ot
However, analysis fails if the custom
assay baseline is used in a run plan.

21320 If the name of a variant report This issue affects any variant report with @,*#, or $ in

template includes a special
character of @,*#, or $, you cannot
view or download variant reports
generated with the template.

the name of the variant report template.

Mitigation: Create a new variant report template
without @,*#, or $ in the name, then generate a new
report.
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17803 The dates for runs that are started This issue affects all runs that are started on or
on or completed on completed on 26—-31 December. The incorrect date is
26—-31 December display the shown in the Variant Report PDF (if Sequencing Run
incorrect year. The date that is Details are included in the report template), in the Run
shown is one year later than the Report PDF, in the Sample Summary file (the info.csv
actual date. For example, for a run file), in the Run Report tab, and in the Run Summary
started and completed on tab.

2021-12-30, the started on and

completed on date is incorrectly

shown as 2022-12-30.

21508 If you have installed lon Torrent™ This issue affects only Oncomine™ Reporter Reports
Oncomine™ Reporter software and in text format.
you generate an Oncomine™ Mitigation: To view an Oncomine™ Reporter Reports
Eﬁg\(l)vritneg; eRrergl?rr;Iens;ea)gef?gngjiasti)ltgfed' in text format, download the report, then view the
“Failed 1o load PDF document ” report in a compatible text file viewer.

23081 When you try to prepare a library This issue affects some system installed and custom
batch with more than 24 samples, an | DNA + RNA assays when you select more than 24
error message is shown for some samples during library batch preparation.

DNA + RNA assays. Mitigation: Create an XLS or XLSX file that contains
the library batch information from a template file
provided in the Import Library Batch screen, then
import the library batch file.

23586 For the Oncomine™ Myeloid v2 - This issue only affects the Oncomine™ Myeloid v2 -
GX5 - DNA and Fusions - w4.2.2 GX5 - DNA and Fusions - w4.2.2 assay.
assay, Purification QC is not Mitigation: Add Purification QC to the assay before
included by default. you copy the assay or use the assay in a run plan.

1. Click Assays» Manage Assays.

2. Place the pointer over the row for the Oncomine™
Myeloid v2 - GX5 - DNA and Fusions - w4.2.2
assay, then click Edit QC.

3. Inthe Edit QC dialog box, click Save.

4. Inthe Manage Assays screen, click the assay
name to view the assay details and confirm that
Purification QC has been added.

20579 For runs that use an assay that has This issue affects all runs that include resequencing.
been enabled for resequencing, the
log files for the resequencing portion
of the run are located in a separate
folder called “Reseq”.
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Impact and Mitigation'
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22005 When you try to download a BAM This issue affects all BAM files larger than 2 GB that
result file that is larger than 2 GB, you attempt to download in the software or from the
the file that is downloaded is 0 KB web services API.
and does not contain any data. Mitigation: For help with the following procedure,

contact a Field Bioinformatics Specialist (FBS).

Pre-requisite: Administrator-level user with a

configured Secure Shell (SSH) key

1. Use a command-line interface to view the BAM
results files in the folder
Iresults/analysis/output/reports/.

2. In the folder of files that is returned, search by
sample name to find the BAM file of interest.
Contact an FBS for help if the result was
reanalyzed and multiple subfolders are listed.

3. Copy BAM files from the server to the computer
with SSH.

The file location on the server is:

Iresults/analysis/output/reports/[Sample specific

LIMS folder].

20738 Downloading multiple Customer This issue occurs when you try to download a CSA file
Support Archive (CSA) files while another CSA file is downloading. This issue
simultaneously fails. occurs in the Run Results, Sample Results, and

Verification Results screens.

Mitigation: You must wait for a CSA file to download

successfully before you can download another CSA
file.

16765 Results generated by the This issue occurs only when you view the
coverageAnalysis plugin for RNA coverageAnalysis plugin results in the Plugins tab for
samples with an application category | an oncology RNA sample.
of oncology are not informative. Mitigation: For oncology RNA samples, you can

ignore the coverageAnalysis plugin results shown in

the Plugins tab.

21486 If you upload a DNA & RNA sample | This issue affects only samples that have a name that
result from one Genexus™ Software | is more than 50 characters long.
server to an.other and the name of Mitigation:
the sample is more than ¢ When you create a sample, limit the name to less
50 characters long, two samples are than 50 characters

he target server. One X
g;e;:ﬁg iosnfc:r DNA (with a sample e For each sample that you want to upload to anther
type of DNA & RNA) and another is Genexus™ Software server, edit the sample
. name so that the name is less than 50 characters.
for RNA (with a sample type of
RNA). e |f two samples are created on the target server,
select both samples when you plan a BAM to
Result run.
16763 If you import run results This issue affects results that are imported in a

from another Genexus™ Software
server that has a different version of
a plugin used in the run, you cannot
see the plugin results in the Plugins
tab when you view the results on the
target server.

Genexus™ Assay Development Software server that
has a different version than the source Genexus™
Software server.

Mitigation: Run the plugins again in the target server
(from a sample result, click the More Options
button® Run Plugin).
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21357 In the Manage Assays screen, This issue affects only the filter selection of DNA and
when you select DNA and Fusions, | Fusions, DNA, Fusions in the Research
DNA, Fusions to refine the assay Application column.
list with the filter tool in the Mitigation: First enter the term DNA and Fusions,
Research Application header, no DNA, Fusions in the search field, then select the
records are shown even if records DNA and Fusions, DNA, Fusions checkbox to refine
are available. the list.

21807 When you create some custom This issue affects some custom assays.
assays or copy and edit some Mitigation: Ignore MSI parameter settings in custom
assays, you can enable, edit, and assays when results do not show MSI metrics.
view Microsatellite Instability (MSI)
parameters in the Parameters step
of assay creation even though the
MSI parameters are not applied in
the analysis.

21712 When you try to sort by name the list | This issue occurs only when you try to sort the list of
of copy number baselines, sequence | copy number baselines, sequence variant baselines,
variant baselines, or exon tile assay | or exon tile assay baselines by name.
baselines, the following error Mitigation: You can sort the lists of baselines when
message appears: "We are unable | v, click any other column header. You can also scroll
to complete the requested action to the bottom of the screen, and if applicable, view
due to a system error. other pages of each baseline, to view the baselines at

the end of the list.

21086 When you click Settings» Backup This issue occurs when you start an unscheduled
& Restore» Start Now, system system backup.
backup starts immediately withouta | mitigation: Ensure that you intend to start a system
confirmation dialog box. backup before you click Settings» Backup &

Restore > Start Now.

794 If a USB update for the purification When you attempt to update the purification

instrument fails, you are not notified. | instrument software from a USB, the message “Install
Completed; Please Reboot Now” appears regardless
of whether the software update is successful.
Tap Instrument Settings» About to view the
software version and confirm that the software update
is complete.

1316 If the error message “Lane clog This is a rare issue that only occurs if the sequencing
check failed” is shown after a clean instrument detects a lane clog after performing a clean
instrument procedure, the message | instrument procedure. If a lane clog occurs and you do
appears only briefly. not see the error message, you are notified to perform

a clean instrument procedure when you start a run.
Mitigation: Contact Technical Support
for help to fix a clog.

IMitigation is included if applicable.

View the correct orientation of transcripts that are transcribed
from the reverse strand

You can view the direction of transcripts and get correct exon numbers with the Broad Institute Integrative
Genomics Viewer (IGV) or with other genome browsers, such as the UCSC Human Genome

Browser.
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Enable IGV

e Pre-requisite:

4.

View a coverage graph in IGV

1.

© N oA ODN

10.

1.

Java™ Web Start version 8 (64-bit) installed. If you are running Java™ 9 or later, you must also
have Java™ 8 for the JNLP to work correctly to view variants in IGV.

Run Configure Java.

In the Java Control Panel, in the Security tab, click Edit Site List.

In the Exception Site List, click Add, enter the Genexus™ Assay Development Software URL, for
example, https://<your server address>, then click OK.

Click OK to close the Control Panel.

In Genexus™ Assay Development Software, click the Variants tab.

In the row of the variant of interest, in the Locus column, copy the locus for the variant.
In the Variant ID column, click the link for the variant of interest.

In the Gene Browser that opens below the variants table, click View in IGV.

In the warning message that appears at the bottom of the screen, click Keep.

At the bottom of the screen, click the name of the file.
In the warning message dialog box that appears, click Continue.

In the Security Warning dialog box that appears, accept the risk, then click Run.
The transcript is shown in IGV in a new window.
In IGV, in the search box, paste the locus that you copied in step 2, then click Go.

File Genomes

View Tracks

Regions

Tools

GenomeSpace

Help

Human hgl9 vi2

v | |chr17

w | chr17:41,078,438-41,316,766

Go

Use the tools in the top right of the screen to expand and shrink the view of the tracks.

= RIARIAT (RERARAARAARAL

In the Sequence pane, view the direction of the transcript and place the pointer over an exon of
interest to view more details.
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For more information about IGV, see the IGV User Guide.

Genexus™ Assay Development Software 6.6 Release Notes

18


https://software.broadinstitute.org/software/igv/UserGuide

System Requirements

Genexus™ Assay Development Software 6.6 has a browser-based interface that can be viewed using
Google™ Chrome™ version 90 and above (version 90 has been tested) and is best viewed with a

1440 x 900 screen resolution. The software is accessed on an independent client computer with a private
web server.

Version information

Release Date June 2022

Release Version 6.6.2.1

Software plugin versions

Plugin Version
customersupportarchive 6.6
coverageanalysis 6.6
molecularcoverageanalysis 6.6
sampleid 6.6

The information in this guide is subject to change without notice.

For Research Use Only. Not for use in diagnostic procedures.

DISCLAIMER

TO THE EXTENT ALLOWED BY LAW, LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) WILL NOT BE LIABLE FOR
SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION
WITH OR ARISING FROM THIS DOCUMENT, INCLUDING YOUR USE OF IT.

Important Licensing Information

The products may be covered by one or more Limited Use Label Licenses. By use of these products, you accept the
terms and conditions of all applicable Limited Use Label Licenses.

TRADEMARKS

The trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

Bitdefender GravityZone is a trademark of Bitdefender IPR Management Ltd. Kaspersky is a trademark of Kaspersky
Labs International. NOD32 is a trademark of ESET.

©2022 Thermo Fisher Scientific Inc. All rights reserved.
For support visit thermofisher.com/support

8 June 2022
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